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Chapter 1
Function Description

Goal:
Describe thermostat flow chart 



Thermostat cycle

∆Set point Temperature

Actuator

ON



Thermostat states (function description)

Actuator

OFF

Actuator

ON

Temp ≥ Setpoint+∆

Temp < Setpoint



Chapter 2
Programming

Goal:
- Familiarizing with programming environment
- Creating Thermostat Function Block



Creating New project

2*click

2*click

1

2



Creating New project

1

1

2



Creating New project



Compatibility with old release

3

Tree project in last 
freestudio release

Tree project in old 
freestudio release

1. Project menu
2. Option command
3. Unselect Use 
customizable workspace
4. Click OK when required 

We can change display 
tree option in order to 
have full compatibility
with follow slides of 
exercise

Выступающий
Заметки для презентации
1. The Output window is the place where Application prints its output messages. 
2. The Status bar displays the state of the application at its left border, and an animated control reporting the state of communication at its right border.
3. The Watch window is one of the debugging tools supplied by Application.
4. The Library window contains a set of different panels, which fall into the categories explained in the following paragraphs.
5. The Workspace window consists of three distinct panels, as shown in the following picture.
6. The Application programming environment includes a set of editors to manage, edit, and print source files written in any of the 5 programming languages defined by the IEC 61131-3 standard.
7. The Oscilloscope window is one of the debugging tools supplied by Application.




Programming environment

1
2
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4
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Programming Languages
The FREE STUDIO platform is compatible with all 5 standard programming 

languages (IEC 61131-3).

5 programming languages, 2 text-based and 3 graphics-based:
• ST, Structured Text,language text
• FBD, Functional Block Diagram language graphical
• LD, Ladder language graphical
• IL, Instruction List language text
• SFC, Sequential Function Chart language graphical



Thermostat program 1. Right click on the programs
2. New program
3. Select language
4. Name it
5. Assign it to the background or timer task
Note: The main (default) program can be 
deleted if not used (Rename is possible, 
Editting language is not possible).

See the next slide for Task detail 
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4
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Associating a program to a task
For a program to run, it must be associated to a task.
There are various types of tasks:
• BOOT Task runs once only at system start-up.

• Init. Task runs each time the application is downloaded and after BOOT.

• Timed. Task runs at regular intervals which can be set by the developer. 
The default setting is 100ms.

•Background. Task runs with low priority after the Timed tasks (between the end 
of one Timed task and the start of the next), it can be interrupted in case of long 
execution or executed more than 1time in case short execution.

Note Each new project has the main program associated to the background task 
(the main program can still be eliminated and/or associated to other tasks).

To activate a task, go to the task you want, right-click and select Add program



Timed Task setting



Tasks
• BOOT Task runs once only at system start-up.
• Init. Task runs each time the application is downloaded and after BOOT.
• Timed. Task runs at regular intervals which can be set by the developer. The default setting is 
100ms.
•Background. Task runs with low priority after the Timed tasks 
(between the end of one Timed task and the start of the next).

Period of 
task timed

Execution 
time of
task timed

Period
task timed

Execution
task timed

Period of
task background

Execution time of
task Background

Actual execution time, background task
Start Execution

Background Task

Read 
Input

Update
Output

Execution
task Boot

Execution
task Init

Update 
Display

Read 
Input

Update
Output

Read 
Input

Update
Output Read 

Input
Update
Output

Update
Output

Update 
Display

Executed only after a 
download



Assigning program to the task

Tasks►Background ►right click ►add program



View FBD toolbar

1. View
2. Toolbars►FBD bar



New function block creation

1
1. Right Click
2. New function block
3. Select the language
4. Assign a name 
5. Double click on the 
Hysteresis to open the 
editor related to the 
selected language.

Note: Try to create function if the 
block does not require static RAM, it 
will optimize the RAM usage.
a function use RAM stack, which is 
allocate when you call the function 
and released just after the call 
execution.
A function block instance instead 
allocate a static RAM equal to all the 
Vars declared in the function block, 
between one call and the following the 
RAM value is maintained.
So if don’t need this feature, i.e. your 
block doesn’t have internal states, it is 
better to implement it as a function.

PID must be a FB because of the 
integral time.
SUM could be implemented as 
function or FB (but it is better to 
implement it as a function).

3

4

5



Insert record

1

2

5
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6

4

5 & 6. Optional

For more information about different 
data types please visit Appendix 1.



Inside Hystersis FBD

Compile result is valid as soon 
as FBD used in the program

Set point
∆
Probe Alarm
Actuator



FBD in Background
1. Double click on the Thermostat programt to 
open the editor that is related to the program
2. drag & drop
3. Name it
4. Add new network

Drag & Drop
1

2

3

2



Set password for written FB

You can prevent access 
to your written codes 
inside of FBD by cript.



Assigning local variable to the FBD

2

1

3

3
1. Add new record
2. Name it
3. Define the type from object browser



Connecting Variables to the FBD

Select Input/output

Drag & Drop

Shortcuts:
Space: Connecting Mode ◄► Insert/Move Mode
Ctrl+Shift+Left Mouse Button: Multiple Selection
Ctrl+Shift+F: Find in project



FBD toolbar…

1 2 543 6 7 8 9

1. Connection
2. Watch
3. New block
4. Variable
5. Constant
6. Return
7. Jump
8. Comment
9. Increase number of pins
10. Decrease number of pins
11. Display enable I/O pins
12. FBD properties
13. View source

1
0

1
1

1
2

1
3

1
1

11. The output will not 
update if En=False

9



Cross Reference

1. Find in project (cross reference)1

1



Tools Configuration



Compile/Build

Compile

Double click on the error to 
refer to the error source



Chapter 3 
Simulation/Debugging – Part 1

Goal:
Debugging created FB by different off-line 
simulation tools such as Watch or Oscilloscope



Off line simulation mode

Debug►Simulation mode ►

1. Debug
2. Simulation mode
3. Name it ► OK
4. If differs or no code
5. Download  the code, OK
6. Reset Variables

1 2

5
4

3 6

5

2



On-Line Status / Application Status

The state of communication is shown in a small box next to the right border of the 
Status bar. 

If you have not yet attempted to connect to the target, the state of communication is set 
to Not connected. 

When you try to connect to the target device, the state of communication becomes one 
of the following: 

-Error: the communication cannot be established. You should check both the physical 
link and the communication settings. 

-Connected: the communication has been established 



On-Line Status / Application Status

Next to the communication status there is another small box which gives 
information about the status of the application currently executing on the 
target device. 

When the connection status is Connected, the application status takes on one 
of the following values. 

-No code: no application is executing on the target device.

--Diff. code: the application currently executing on the target device is not the 
same as the one currently open in the IDE; moreover, no debug information 
consistent with the running application is available: thus, the values shown in 
the watch window or in the oscilloscope are not reliable and the debug mode 
cannot be activated. 



On-Line Status / Application Status

--Diff. code, Symbols OK: the application currently executing on the target 
device is not the same as the one currently open in the IDE; however, some 
debug information consistent with the running application is available (for 
example, because that application has been previously downloaded to the 
target device from the same PC): the values shown in the watch window or in 
the oscilloscope are reliable, but the debug mode still cannot be activated. 

-Source OK: the application currently executing on the target device is the 
same as the one currently open in the IDE: the debug mode can be activated.



Debug mode/Changing values

1. 2*click on required variable
2. Edit the value
3. Set the values
4. Check the Output status
5. Check the Alarm status 

In probe disconnection, short circuited or 
broken the value= - 32768

6. Debug mode (optional)
7. Live (continuous) debug mode (optional)

2* Click

Edit value

7

4

1

2

3

5

6



Watch configuration

Save watch list

Drag & Drop

Watch list formats

Watch list is 
independant from 
live debug mode



Watch/ drag & drop

1. Select watch icon
2. Select the variable
3. Select the watch
4. ► OK
5. It adds to watch list

1

2

43



Watch Configuration/ST language

1. Select the variale
2. Double click
3. Drag & drop it directly to 

the watch properties1 2

3

*



Oscilloscope
View ►Tool windows ► Async graphic windows ►



Assigning variable to the oscilloscope

Drag & Drop

Up to 8 channels could be 
traced simultaneously



Assigning variable to the oscilloscope
1. Select watch icon
2. Select the variable
3. Select the Oscilloscope
4. It adds to oscilloscope list

2

4
3

1



Oscilloscope tools/starting & stopping data acquisition 

When you add a variable to the Oscilloscope, data acquisition begins 
immediately. 

However, you can suspend the acquisition by clicking on Pause acquisition.
The curve freezes (while the process of data acquisition is still running in 

background), until you click on Restart acquisition. 

In order to stop the acquisition you may click on Stop acquisition.

In this case, when you click on Restart acquisition, the evolution of the 
value of the variable is plotted from scratch.



Oscilloscope tools/ Vertical split

1.Selected track‘s vertical show all
2. Horizental show all
3. Show all values
4. When you are watching the evolution of two or more variables, you may want 

to split the respective tracks.
5. The tool highlights the single values detected during data acquisition. 
You can click on the same item again, in order to go back to the default view 

mode.
6. The Oscilloscope includes two measure bars, which can be exploited to take 

some measures on the chart.

14 3 256



Oscilloscope tools/ Setting the scale of the axes

When you open the Oscilloscope, Application applies a default scale to the axes. 
However, if you want to set a different scale, you may follow this procedure: 

1) Open the graph properties
2) Set the scale of the horizontal
axis & sampling polling rate
3) Specify a distinct scale for the
vertical axis. 
4) Confirm your settings. 

2

4

3

1



Oscilloscope/export

1. Save icon
2. Name & format defining

-OSC: simple plain-text file, containing 
time and value of each sample

-OSCX: XML file, that includes more 
complete information

3. Open it via Excel (OSCX )

1

2 Available formats
2

3



Chapter 4
Resources

Goal:
Defining the resources:
- Assigning physical Input/output
- EEPROM parameters
- Status variables
- Menu definition and navigation



Physical I/O Mapping (Base Unit)...

1

2
3

4

1. Resources
2. I/O mapping
3. Local
4. Name variables

2. I/O Mapping definition:

Local: Base I/O
Extend: Expansion
Remote: Keyboard



...Physical I/O Mapping (Base Unit)...

After saving the project, all 
the defined resources will 
be available under Global 
shared folder; 
Mappings in case of I/O

1

2

2

NTC_Probe

NTC_Probe



...Physical I/O Mapping (Expansion)

1

2

After saving the project, all 
the defined resources will 
be available under Global 
shared folder; 
Mappings in case of I/O



How to configure I/O types, range?

1. Menu Developer ► Open with free studio device

Note: BIOS parameters are also available on the installation manual

1



Check FS Device parameters description...

1



...and define the Application BIOS Default

1. BIOS parameters
2. Add
3. Select the name
4. Select the type

31

2

4



EEPROM parameters

3

1. Resources
2. EEPROM parameters
3. Add
4. Define required „retain“ data
5. 1% resolution

Format XXX.Y
Note:Default values are written to the 

target  only by Free Studio Device

1

4 5

App. Type : IEC variable type
Device Type : FS Device / Display type
App. Type = Scale x Device Type + Offset

2



EEPROM Properties

1

1

EEPROM Parameters:

App. Type : IEC variable type
Device Type : FS Device / Display type
App. Type = Scale x Device Type + Offset

Note.
Dynamic setpoint by the other parameters
Min/Maxis possible.

4

2 3

42 3



Status Variables

1

2
3

1. Resources ►Status variable
2. Add new record
3. Define required RAM data
4. Valid range

Note: Same properties as 
EEPROM + read only

App. Type : IEC variable type
Device Type : FS Device / Display type
App. Type = Scale x Device Type + Offset

4

3



Alarms

1

2

3

4

1. Resources
2. I/O mapping
3. Alarm
4. Add

4.1   Name
4.2   without short name
4.3   7 segments preview
4.4   with short name
4.5   7 segments preview

- It is automatic folder which display
the Alarms, if value is 0, no display 
In AL folder if alarm value is 1, 
displays  the short name.
blinks if value> than 1.
- In case of any alarms, the red 
triangle icon in the display is on.



Fundamental state display configuration

- Display
- Fundamental state display
- Desired variable in the display



Menu Program – Add Folder

1. Menu Prg.
2. Add Menu
3. New Menu, name it (Cfg)
4. 7 segment preview

1 2 3 4



Menu Set – Add Folder

1. Menu Set, Right Click Add Menu
2. New Menu, name it (Setting Menu)
3. 7 segments preview

1 2 3



Add/Remove elements to folder

1 3

2

1. Add
Open the list sorted by names

2. Select the parameter
3. Add again
4. Select the other parameter4



Add/Remove elements by drag & drop 

Drag & Drop



Menu Program – How to Access

To form & define the program button function:
1. Menu Prg, access by pressing Prg button in simulation
2. Menu Prg, access by pressing esc.& set buttons 

simultaniously on the product
3. Scroll up or down into the defined variables ▲▼

1

2
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Menu Set – How to Access

To form & define the set button function:
1. Access to the set menu by pressing set in simulation
2. Access to the set menu by pressing set on the product
3. Scroll up or down into the defined variables ▼▲

1

2

3



Menu architecture

MSet

Main Menu

AlPassPar

I/O M

SetPrg

↑ ↓ ↑ ↓ 

Main Menu

↑ ↓ ↑ ↓ 

Cfg

Diff SetP

Temp

Main Menu

Set

F5

ValueValue

Value

0 Err1

Free

Prg

Cf

PassPar

↑ ↓ ↑ ↓ 

Set

Cf**

Set

F5

Set

Set

↑ ↓ ↑ ↓ 

SetSet

Set

Set Set



Project / Global Shared

Drag & Drop

All the resources are available in the 
project tab under Global Shared folder 
(after saving or compiling the project)



Using physical I/O 

Drag & Drop



System LED setting

1

2

4

3



System local LED assigning
1. 2*click
2. Variable property
3. Dedicate required LED
4. Type [6] ► Output ► OK
5. Type [9] ► Output ► OK
6. Type[10] ► Output ► OK
7. Dedicated LED‘s

1
2

3

4 5 6

7



Connecting dedicated LED‘s to the FBD

1

3

2

4

5

Digital Input map

Digital output map

4



Valorize Fundamental State Display
1

3

2
v

47

1. Insert bottom (new network)
2. Adding new network
3. Select Move block
4. Drag & drop to new network
5 & 6. Mapping ◄► Variables
7. Connect to Move block

* Move command is mandetory to connect two variables.

5
6



Compile/Build

Compile

Double click on 
the error to refer to 
the error source



Chapter 5
Simulation and Debugging – Part 2

Goal:
On-Line simulation mode, testing of:
- Physical I/O 
- 7 segment display 



Off line simulation mode

Debug►Simulation mode ►

1. Debug
2. Simulation mode
3. Name it ► OK
4. If differs or no code
5. Download code, OK
6. Reset Variables
7. Debug mode (optional)
8. Live debug (Continuous) mode (optional)

1 2

5
4

3 6

87

5



Simulation tools
1. Active code execution
2. Show I/O panels
3. Show HMI window

1 2 3



Opening Device from Application

1. Developer ► Open with Free Studio Device

1



Free Studio Device (Simulation Target)

Connect to the target►Connected feedback

Note: Free Studio Device does not download the code in Simulation, it 
is used only for setting EEPROM parameters and check Status



2

Read / Write Values

1. Connect to the target►Connected feedback
2. Application►Project►Cfg
3. Cfg menu►non aligned value with target (Red)
4. Auto refresh mode (optional)
5. Select all parameters (or selective)
6. Write parameter (all or selective)+ download all
7. Aligned values  with the target (black)

1

3

4

5

6

7

6



Menu Navigation

Start - Prg - Set

Set ▲,▼



Setting the setpoint

Start

Press Set to validate
Press esc  to cancel

Set ▲,▼

Defaul value aligned with
the Free Studio Device



Setting the differentiation

Start

Press Set to validate
Press esc  to cancel

Set ▲,▼

Defaul value aligned with
the Free Studio Device



Message

Out of range message
Only can disply:
- 99.9.....999.9 

Device does not write
default values



Testing program/applying values

 Setpoint=26.0, Differentiation=10.0 & Ambient_Tempereature =37.0 
⇒ DOL1= ON & ☼ = ON  

 Setpoint=26.0, Differentiation=10.0 & Ambient_Tempereature =25.0
⇒ DOL1= OFF & ☼ = OFF 

 Setpoint=26.0, Differentiation=10.0 & 26.0<Ambient_Tempereature<36.0 
⇒ DOL1= ON & ☼ = ON

 Ambient_Tempereature =-32768 
=> DOL1= OFF , ☼ = OFF & DOL2= ON (probe disconnection alarm= ON) 



SMART Project Architecture

●Application is the programming starting point.

●Device is used to download the overall compiled project and it is the only tool able 
to write EEPROM parameters.

●From Application it will always be possible to open Device directly without having 
to launch the program using the FREE Studio icon.



Tools workflow/Optimized

Download
Code & EEPROM

Download
Code & EEPROM



Chapter 6
Hardware

Goal:
Introduction of products that are used in 
training stand and target pin-out



1. SMART
2. EVOLUTION
3. Expansion Module
4. Remote Keyboard
5. Digital input

I0-I7 ► EVP3300
I8-I15  ► EVE*

6. Digital Output
Q0-Q3 ► SMART
Q4-Q9 ► EVOLUTION
Q10-Q15 ► EVE*

7. 24VDC power supply
8. NTC probes (AI1*) 
9. Analogue Output

AO1 ► SMART
AO2 ► EVOLUTION

10. Analogue Input
AI1 ► SAMART
AI2 ► EVOLUTION
AI3 ► ATV21

11. Digital input
I0 & I1(level) ► SMART
I2 & I3 (edge)► EVOLU.

12. Variable Speed Drive
ATV21 (1 to 3 phases)

13. Short circuit 
ptotection (GV3P)

14. LV distribution &  
protection

15. Asynchronous motor

9
8

765
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Training Stand I/O wiring diagram
M171O Description Label

DI1 Switch DI 1 (level) DI0-O

DI2 Switch DI 2 (Level) DI1-O

DI3 Switch DI 3 (Pulse) DI2-O

DI4

DI5

DI6

AI 1 NTC 1 AI1-O

AI 2

AI 3 Potentiometer 1 AI3-O

AI 4

AI 5

DO 1 Telefast DO 0 DO0-O

DO 2 Telefast DO 1 DO1-O

DO 3 Telefast DO 2 DO2-O

DO 4

DO 5

DO 6

AO 1

AO 2

AO 3 Meter 1 AO1-O

AO 4

AO 5

M171P Description Label

DI 1 Telefast DI 0 DI1-P

DI 2 Telefast DI 1 DI2-P

DI 3 Telefast DI 2 DI3-P

DI 4 Telefast DI 3 DI4-P

DI 5 Telefast DI 4 DI5-P

DI 6 Telefast DI 5 DI6-P

DI 7 Telefast DI 6 DI7-P

DI 8 Telefast DI 7 DI8-P

AI 1 NTC 2 AI1-P

AI 2

AI 3 Potentiometer 2 AI3-P

AI 4

AI 5

AI 6

DO 1

DO 2

DO 3 Telefast DO3 DO3-P

DO 4 Telefast DO4 DO4-P

DO 5 Telefast DO5 DO5-P

DO 6 Telefast DO6 DO6-P

DO 7 Telefast DO7 DO7-P

AO 1 Meter 2 AO1-P

AO 2

AO 3

AO 4

AO 5

M171E Describtion Label

DI 1 Telefast DI 8 DI1-E

DI 2 Telefast DI 9 DI2-E

DI 3 Telefast DI 10 DI3-E

DI 4 Telefast DI 11 DI4-E

DI 5 Telefast DI 12 DI5-E

DI 6 Telefast DI 13 DI6-E

DI 7 Telefast DI 14 DI7-E

DI 8 Telefast DI 15 DI8-E

AI 1 NTC 3 AI1-E

AI 2

AI 3

AI 4

AI 5

AI 6

DO 1 Telefast DO9 DO1-E

DO 2 Telefast DO10 DO2-E

DO 3 Telefast DO11 DO3-E

DO 4 Telefast DO12 DO4-E

DO 5 Telefast DO13 DO5-E

DO 6 Telefast DO14 DO6-E

DO 7 Telefast DO15 DO7-E

AO 1

AO 2

AO 3

AO 4

AO 5



Wiring Diagram

SMD5500/C/S EVD7500/C/U



SMART Pin-out

SMD5500/C/S



SKW22 and SKP22 Remote Display



SKP10 Remote Display



NTC probe,Type: 103AT/NTCNK103



AT THERMISTOR
AT THERMISTOR
The AT thermistor is a high-precision thermal
sensing device featuring an extremely small
B-value tolerance and resistance.
When used as a temperature gauge, the AT
thermistor requires no adjustment between
the control circuit and the sensor.



Probe Properties



Chapter 7
Connection to SMART

Goal:
DMI interface driver installation and connect to 
the target



DMI interface setup WIN 7

●As soon as the DM interface is connected, the Windows 7 operating system 
recognizes the newly connected hardware. The steps to be followed are 
described below.

1.Once the hardware is connected, the message shown in the figure will 
appear:

Click on the message to start the 
Guided installation procedure 
Or you can manualy find it at:

Device manager ► other devices ►

Note: Connection procedure:
Connection: first USB then TTL
Disconnection:  first TTL then USB



Update driver software

2. The screen shown below will appear: select the second option to identify the 
driver

3. In the next screen, select the installation path for the FREE Studio program. 
Unless changed during installation, the path will be as shown in the next  
figure.



Update driver software

4. Once you have selected the correct path, the screen shown below will 
appear: select Install this driver software anyway



Update driver software

5. The screen shown below will appear, indicating that the action has been 
performed.

6. On completion of the process, the screen shown below will appear, then close.



DMI Test via FS Device
To check correct installation of the driver and the port to which the hardware 

has been allocated, check the Windows screens shown below:

Default Address 
range is between 
1 to 5



Connection to M171O
To download the IEC applications of STUDIO from the PC to the SMART:

Note: in “Direct”, SMART must not BE connected to earth
- it can switch on SMART without external power supply



SMART
Preliminary operations
In order to download the application correctly:
1. connect the DMI hardware interface to the PC.
2. Make sure that the driver is installed

Press Settings
The COM port must previously have been 
read/set in “Peripherals Management” 
(see Reading the DMI interface COM port) 
to be recognized. If there are errors, refer to the 
paragraph “DMI interface connection error”.
* the COM settings must be set on all of the workspaces: Application, Device and User Interface

Connection to SMART

1

2

3
4



Connect to the target

Protocol Configuration

●For SMART select EWDMI or Modbus*. If the protocol is not activated 
press the Activate button

●The value selected for the COM port will be saved and will reappear each 
time the program is accessed, until it is changed.

●The properties are visible and can be edited from the panel Communication 
> Settings > Properties**

* in the case of Modbus for /S models only with maximum speed  
19200 baud. TTL not for use. NOT POSSIBLE TO UPDate the BIOS.

** obviously, the protocol must be activated beforehand

Factory default configuration:

Address:1, Baud rate: 9600
E,8,1 (CF30=1, CF31=3, CF32=1)



DMI interface connection error

Error opening serial port

If the “Error opening serial port” message appears, proceed as follows:

1.Check that the COM port setting in the program is the same as one read in 
the COM port reading by the DMI interface.

2. Check if Com Server is opened when you try to connect to Smart. If not 
disconnect TTL cable, USB port and reconnect first USB and then TTL.

3. Repeat the DMI Detection function.



Target and Free Studio

Parameters needed for correct connection between the SMART target and Free 
Studio.



Customize SMART Baud Rate
SMART parameters in the CF folder manages the connection between the target and Studio
If the target is “empty”, i.e. there is no IEC application on the device, SMART will display the 

message FrEE, otherwise fundamental state is displayed (Press F5 to switch to FrEE menu) 

1 2
3 4

5 6



Customize SMART Baud Rate by FS Device

Only After Connection has been estabilished:

1. Project ►BIOS parameters►All parameters►Configuration
2. CF31 editing►38400 bits/Sec.

2

1

Protocol parameters are loaded at power up, remember 
to switch off controller after changing them.



Device Tool- Main icons

1 2 3 4 5
1. Continuous read/write by toggle auto 

refresh mode. As soon as value changes, 
it will automatically aligne with the target.

2. Select all variables
3. Read all device parameters
4. Write all device parameter
5. Download all (PLC & parameter)
6. It is possible to check the firmware 

version via information. 

6



Free Studio Device - Colors

1. If the auto referesh is on the 
column value is continiously 
updated and values are written as 
soon as you change them.

Color meanings:
Red: not aligned with the target
Grey: read only data
Blue: value is different from default
Green: data is not visible in the target
Black: aligned with the target 
(if auto referesh is enabled).

1

1



Connect to the target and Download All

1. Connect
2. Download All
3. Write the default 

parameter values
4. DMI Blink: 

Communicating

1
2

3

2

4



Editing value
1. Be sure to be Connected
2. Set or change the value (Red, not applied)
3. Write the parameter (Black, applied)1

2

3

2



Oscilloscope
Drag & Drop



Oscilloscope

1. Show all values
2. Graph properties
3. Value/div=20 ► OK
4. Vertical split

1 24

3



Oscilloscope



Debug on-line/Watch

Select variable to watch

1

2

4
3



System Local physical I/O watching

1
2

Drag & Drop



Watching Expansion Status & I/O

Note. In case of loosing communiucation 
between Base & expansion:
All DO‘s = 0
All DI‘s = False
All Probes = -32768

1. It can use as communication alarm variable
2. They can only use in watch

1

2

Drag & Drop



Physical I/O monitoring via 

1 2

3

4

5



"States" menu

1
2 3



System Local Keys



Definitions



System Local Key Program



Chapter 8
Remote LCD Display

Goals:
Mirror Ambiant temperature & Set point in 
LCD
Icons activation
Monitor LAN 
Configure embedded analogue Inputs 



Hardware Description



Architecture

Maximum configuration : 1 CPU + 1 Expansion 
(SME__) + 1 LED display (SKP10) + 1 display 
(SKP22 or SKW22)



Pin-out descrption



Remote I/O Cfg.

1



Remote LCD display BIOS Param.



Remote I/O mapping+EEPROM



Status Variable declaration



Assinging Physical Input 2 Status Var.



Remote Display Icons

A26

A25



Icons Vector 1

A19 has priority on A25/A26, 
i.e. if A19 is on the other two 
are forced off.



WriteNumLCD



WriteClockLCD



WriteStringLCD



LCD Icon’s assignment…



…LCD Icon’s assignment



Watching/Monitoring LCD icons

1
Drag & Drop



Watching/Monitoring remote I/O

1



Watching/Monitoring LAN communication

1



SysDisplayMode

1



Dashboard

Digital Output 1 ▲



 



 

▲
☼

Digital Output 2

SetPoint

Ambiant Temp.

Operation Mode Control Mode

Unit Measurment

Unit Measurment

..



Chapter 9
Target conversion and code import

Goal:
Reuse of existing code and libraries



Convert project from Smart to EVOLUTION
1. Project ► Select target
2. EVD 
3. Change
4. Save the project

1

4

By target conversion, 
it is possible to reuse 
the existing projects. 3

2



Converted project from M171O to M171P

Conversion between Evolution to Smart is not fully 
supported (all resources are deleted).



Import Objects from library (or Project)

It allows also to import programs, FB, functions from other projects regardless the related target.

Both directions, upgrade & 
downgrade are possible, from:
SMART ► EVOLUTION
EVOLUTION ► SMART



Import Objects from Project...

1. Select *.ppjs file type
2. Select desired project (SMART)
3. Select desired program & FBD
4. Import Objects

1 4

3

2



...Assign to Task (in case of program)

1. ? Means that program is not assigned to any task
2. Tasks ► Background ► Add program

1

2



Assigning imported program to the task

1. Select  the desired program 
name ► OK

2. The ? Disapeares in prgrams 
3. It will assign to to desired 

task (delete non-required 
programmes)

1

1

22

3



2

Link libraries...

1. Project ► Library Manager
2. Project Library list
3. add/remove
4. Unlink/Relink

1

4

3

2



...Link Libraries

1

2



Chapter 10
Methodology:

Goal:
Navigation between the SW, application, 
device, connection & familiarizing with their 
abilities



Free studio/unique programming software

In Unique software suite for Smart and Evolution

Smart Evolut
ion



Software suite presentation

Smart+Evolution         Evolution



Smart Project Architecture

●Application is the programming starting point.

●Device is used to download the overall compiled project and it is the only tool able 
to write EEPROM parameters.

●From Application it will always be possible to open Device directly without having 
to launch the program using the FREE Studio icon.

Download
Code & 
EEPROM

Download
Simulated
EEPROM



Tools workflow/Optimized

Download
Code & EEPROM

Download
Code & EEPROM



Evolution Project Architecture

●Connection is the entry point for all development activities.
●Device is used to download the overall compiled project and it is the only tool 

able to write EEPROM parameters and the master connectivity configuration
●Application can download only the algorithm and the EEPROM parameters 

and Status Variable definition.
●UI can download only the HMI to EVD
●UI can open SI as well

Download Code, 
HMI & EEPROM

Download
Simulated 
EEPROM



Tools workflow/Optimized

Download
Code & EEPROM

Download
Code & EEPROM

O
pe

n 
w
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Chapter 11
Fan Management

Goal:
Manage 3 fans base on analogue input 
configuration



Physical I/O assignment
Fan Management Function Description:
Fan Management enable by DIL1=True
If AI3P <= 3.3 V => Fan1=ON
If  3.3 V < AI3P < =6.6 V => Fan1 & 2 = ON
If AI3P > 6.6 V => Fan1,2 & 3 =ON
If AI3P = - 32768 => Alarm=ON & Fans=False
Monitoring AI3P by the gauge that is 

connected to the AO1P (0-10 V).

1

2

2

2
P



BIOS Parameters/AI* Configuration



New program creation

Click on the magnifying-glass to write the codes.

1

2

3
101
001



Fan Management, 
Enable/Disable Outputs,
AI monitoring by AO (0-10 V),  
AI disconnection detection codes.



Debugging/Watch 

3. Drag & Drop the mappings 
into the watch window. 

1

2

3



Debugging
/Oscilloscope:



Analogue Input Configuration

1 2



Analogue Output Configuration

1

2



Chapter 12
Network

Goal:
Expansion connection to the base unit via CAN 
BUS 



M171P Networking Exercise 
Can Bus

ExpansionBase 
Unit

NOTE: Leave the CanOpen end resistor jumpers only to the endline Devices, in this case EVD1 and EVE1

Goals:

• Connect an expansion module to Can Bus,
• Configure the physical I/O
• Read/write Digital & analogue I/O
• Monitor the communication between base unit & expansion



Note: Connect GS,H,L of EVD to 
GS,H,L of Expansion respectively

DO NOT CONNECT together POWER 
OUT, POWER OUT is just for 
powering the remote display.

CAN Architecture



Creating New project‘s connection

2*click

2*click

1

2



Connection Configuration

1. Select the base unit, FreeEvolution EVD
2. Validate adding the controller

1

2



Define the Project Architecture



Saving Connection project

1. Save the connection project
2. A folder with defined name & Name.CON file 

will be create in the mentioned directory

1

2



Saved Project

Dictionay Organization:
When a project is created & saved from CO a 
directory will be create; then if AP created by new
from CO;  a directory of the project is created inside
the CO directory

Already existing PLC/HMI project can be 
linked through the related project field.

If it is empty, a new project will be 
created and saved in a folder placed 
where the connection project is saved



Project foldering & Saving Procedure

Application Folder
Projects name.PPJS

Connection Folder
Projects name.CON

Projects name.CON 
must be locate in the 
projects folder‘s root

Copy/Cut & paste the application 
folder inside the connection folder

Project Folder



CANopen configuration
● The CanOpen address of EVD is 125, it 

will written in the CONNEC.PAR file, CAN 
On Board parameters are not valid if the 
Evolution is Master on CAN.

● EVE must be set at the speed defined 
here (if changed the devices must be 
restarted, Factory default is 500Kb/s)



● Drag & drop from device catalogue to the CANopen
● Or
● CANopen►Add►Device catalogue►Select the target

Add an expansion



Expansion configuration

• Node Number is the address to 
be set on Expansion Module   
via Dip Switch.



Expansion Dip switch setting ►Addressing

Node Number=Dip switch +1
2=1+1

Node Number=Dip switch +1
1=0+1

It is possible to connect up 
to 12 expansion+2 keyboard



Expansion Module Dip Switches



Dip Switches Definition



Linking Application Project

1

2

3

4



Launch Application via Connection



Build the connection
1

Note:
To apply the changes to the network,
free studio asks you to reboot.

2



Define Application Variables to
be linked to Physical I/O of Expansion module

●NOTE: If the Status Variables is defined in order 
to be linked to an Expansion Module input 

it must be set as not READ ONLY

1. Add
2. Name it
3. Define the type
4. Define the In/Out

1

43
1

2



Expansion module configuration

- Select the Analogue Input 
1 of Exp_1, PDO Tx – Input
- Press Assign
- Link the Physical input to 
the desired Application 
variable
- Repeat this for each Exp 
Input used in your project
- Use PDO Rx – Output for 
Exp Output

Digital Inputs

Dip switches

Analogue Inputs

Fast Digital 
Input



Assign/UnAssign of physical I/O

2

1
4

3

1. PDO Tx-Intput
2. Choose PLC variable DI
3. Choose PLC variable AI
4. Assign

5

3

6



Assign/UnAssign of physical I/O

1. PDO Rx-Output
2. Choose PLC variable DO
3. Choose PLC variable AO
4. Assign

4

3

1

2

5



Status Variable

●Create Status Variables readable via Modbus



Communication Alarm Checking, Link Exp’s I/O



Application Project

You can create your Application project in the usual way using local and field I/O
●sysPeripheralStatus[3] tells the communication status with EVE_1

Note: index to be used with
sysPeripheralStatus[ ], 
index = node number + 2



Phsysical architecture & monitoring CAN Bus

CAN BUS



LED management

1. Resources ► Status variables
2. Add  
3. Define: Name, device & application types

1

2

3



Expansion Module LED Values/Colors



LED assignment



Status/Move function



CAN monitoring program

1.Project ► Programs ► new program
2. Name it as: EVE_Comm
3. Assign it to the timed task
4. Program
5. Communication configuration ► OK



Base Unit LED management



LED management by Enumerators

1 4

2

5
4

3

6



Menus/Status
● Create folder to be shown on Device



Menus/Setting
● Create folder to be shown on Device



Build the connection
1

Note:
To apply the changes to the network,
free studio asks you to reboot.

2



Open with free studio device

1

2



PC TCP/IP configuration
1

4

3

2

5

6

7



Modbus TCP/download

4

3

2
1

5

5.change Timeout 
and Connect 
Timeout based 
on the Ethernet 
band available. If 
the connection 
it is not direct it is 
better to increase 
both of them
10000-20000



Port Scan tool

1

4

3

2



On-Line CAN Bus monitoring

1

4

3

2

3

Drag & Drop



Device’s parameter Configuration/Base



Device’s parameter Configuration/Exp



Expansion module configuration

●Pressing Add you can eventually define the I/O configuration of Expansion 
that Base unit will send at powerup.

●For example: Expansion AI3 is set as 0-10V.

3
2

1

4



Chapter 13
Modbus Communication

Goal:
Connection ATV21/212 to the EVOLUTION via 
Modbus serial line, write the command + speed 
reference and read the output frequency  



Machines architecture

Program.
port

EVD*

or BMS 
Modbus
Master

Magelis Family Range

Modbus Slave
USB/RS485

Other Machines

Altivar Drives e.g ATV212/21 

Modbus Master 

3rd Party Modbus 
slave device

• On Board RS485 SL can be either Master or Slave
• Plugin RS485 SL can be either Master or Slave
• They can’t be both master at the same time



ATV 21/212 via Modbus

Set ups at ATV21:
-LOC / REM = off
-CN0d = 2 Enables Start / Stop control via network
-FN0d = 4 Enables frequency reference to be 
Controlled by network. 
-F800: 1 (default) = 19200bps
-F801: 1 (default) = even parity
-F802: 1 = Address of ATV21 
-F803: 4 = Timeout in seconds
-F829: 1 (default) = Protocol Modbus RTU
-F851: 1 = Communication fault setting 
-(Last commanded operation continues) 



Modbus – ATV21/212

● Drive (slave)
● use Drive Keypad for setting Modbus parameters

Выступающий
Заметки для презентации
Evtl. Beschreibung zu Export Entities… schon hier!?



Modbus – ATV21/212 navigation
● Drive (slave)

● Drive Menu
1. MODE

2. DOWN KEY 2x

3. ENTER on F---

Extended 
Parameters

Выступающий
Заметки для презентации
Evtl. Beschreibung zu Export Entities… schon hier!?



Modbus – ATV21/212 configuration
● Drive (slave)

● Drive Menu 1. Press DOWN key repeatedly 
advance to F829

2. press ENTER key to change 
setting

3. with UP/DOWN keys change 
value

4. press ENTER to confirm and exit

5. repeat for parameters listed 
below

1

1
1

1

Important: Cycle 
power on drive 
after changing 
Modbus settings 
for changes to 
become effective.

Выступающий
Заметки для презентации
Evtl. Beschreibung zu Export Entities… schon hier!?



Modbus – ATV21/212 configuration
Command & Speed Reference



Modbus – ATV21/212 configuration
Command & Speed Reference

2

1

4

3

Mode ► AUF ► 5*▲ ► fmod ►ENT 
► edit value ► ENT to validate

Mode ► AUF ► 4*▲ ► cmod ►ENT 
► edit value ► ENT to validate1

3



Modbus link
- Developer must define a set of variables corresponding to what he 

wants to read or write via Modbus using Status Variables.

Registers:
- Command= 64000+1 (W ►FC16)
- Speed Reference = 64001+1 (W►FC16)
- Output Frequency = 64768+1 (R►FC03)

Message for ATV command:
- Start Command= 50176
- Stop Command= 49152



Modbus Master Configuration

1. Project ► RS485
2. Modbus configuration
3. Select Generic Modbus from 

the catalogue list
4. Drag & Drop it into the RS485 

1
3

2



RS485 On Board parameters



Generic Modbus

1. After drag & drop
2. Name it & define the Modbus address. 
It is recommended to set the Node number the 

same as the Modbus address
3. Select the desired function code from 

catalogue
* Note: Vectors sysMbRtu* in the folder Modbus 

Master are addressed by node number

1

2

3*



Modbus Function Code

1

2

3

1. Select the required function code
2. Drag & drop it into the Project 
► RS485 ►Generic Modbus 1 
3. Do the general settings 
Registers:
Command= 64000+1 (W  FC16)
Speed Reference = 64001+1 (W  FC16)
Output Frequency = 64768+1 (R FC03)

Message for ATV command:
Start Command= 50176
Stop Command= 49152

Important: Some slave devices 
requires an offset of one to 
register Address: ATV requires 
it, EVOLUTION doesn‘t need it.



Modbus Function Code/Settings

1
2

3

1. Start address: address of the first modbus 
object to read or write (1..65536).

2. Polling time: minimum waiting period 
between 2 message processing (ms); for 
writing operations, 0 means to write it only on 
variation of the value, for reading operations 0 
means maximum speed.

3. Timeout: the operation will fail when this 
time-out expires (ms). 

4. Wait before send: Waiting time after end of 
previous message response 
(suggested time >=10ms).

Note: Follow below order in Modbus:
1. Write (FC16)
2. Read (FC3) 

4



Multiple Reg.

1

1. Press Add/Remove in order to define how many 
registers should be written

2. Assign
3. Choose PLC variable ► OK

Note:
- ATV  does not support more than 1 read/ write 

register with the same message
- Waiting time after end of previous message 

response (suggested time >=10ms)

2

3



Generic Modbus\Register

If a status variable is 
used to write a value 
on variation and to 
read the same value, 
the related write 
message must be 
listed in Connection 
before the 
corresponding read 
message



ATV control, Local variable definition

Note: Two 
independant group 
of blocks must be 
place in two 
separate networks



System Modbus RTU Node Status



Modbus Communication Alarm



Recompile & Build
1

Note:
To apply the changes to the network,
free studio asks you to reboot.
Yes: if you want to validate it.
Cancel: if you want to dismiss

2



Open with free studio device

See next chapter for further 
details on download via TCP



Modbus Monitoring

1

4

3

2
Drag 
& 
Drop

4



SysMbMRtuNodeStatus properties



Live debuge ATV* control



…Creating a new Modbus custom device 

Note: To create a new 
Modbus custom device, 
choose Tools / Run 
ModbusCustomEditor; the 
external 
ModbusCustomEditor tool 
will be launched, with a 
new empty document. 



Creating a new Modbus custom device… 
Note:
Advantage:  Easier to be used in Connection
Disadvantage: Message are not optimized & 
common polling time for all messages

1
2

3



Custom Editor/Saving & Implementation

2

1

5
Drag & Drop

3

4



Custom Editor/Output Configuration



Custom Editor/Input Configuration



Chapter 14
Modbus TCP

Goal:
Modbus TCP configuration, project download 
and socket management



PC TCP/IP configuration

1

4

3

2

5

6

7

2



Modbus TCP/download

6

4

3

2
1

7

5

5.change Timeout 
and Connect 
Timeout based 
on the Ethernet 
band available. If 
the connection 
it is not direct it is 
better to increase 
both of them
10000-20000



Modbus TCP/debugging

5

4 3
2

1



Chapter 15
Modbus Slave

Goal:
Configuration of Free Studio to establish 
connection between 
Vijeodesigner & EVOLUTION via:

1.Modbus TCP/IP – Vijeodesigner off line 
simulation
2.Modbus RTU – Megalis target 



Vijeo Designer Installation

1

2



New Project creation/Modbus TCP-IP

1

TCP/IP



General Settings
1 2

3

TCP/IP



I/O manager definition

1

2
3

4

5

6

1. Right Click►insert new driver
2. Select the driver
3. Select the equipment
4. Set the equipment address
5. Use the IEC syntax
6. Validate 

TCP/IP



Renaming created driver &equippment

1

TCP/IP



External Variable Definition

1

2

3

TCP/IP



Variable Properties/Addressing

1

3

1. Check the status variable address defined in controller
2. Define an external variable in HMI side

2 Note: No 1 bit shifting is needed

TCP/IP



Assigning the variable to the Numeric disp.

1
2

TCP/IP



Numeric Display Properties

1

3

4

2

TCP/IP

1



Forming the Panel

2

1

3

TCP/IP



Running Simulation

2

3

1

TCP/IP



EEPROM parameters assigning

1

2

TCP/IP



Numeric Display settings/Enable Input 

1

3

4
2

5

TCP/IP



Panel forming & Simulation

2*Click

TCP/IP



ATV control/ final goal
TCP/IP



ATV Ctrl./Variable & Panel declaration
TCP/IP

1
2

3

4



2

ATV Ctrl./Command & Status
TCP/IP

1
1

2

3

3



ATV Ctrl./Output Freq.
TCP/IP

1

1



ATV Ctrl./Speed Reference
TCP/IP

1

1



ATV Ctrl./Page switching
TCP/IP

1

1

1



ATV Ctrl./Page Switching
TCP/IP

1

1

1



Target Download via USB or Ethernet

1

2 3



Modbus Slave

●Status variables and EEPROM parameters have a modbus address and they 
are all Holding Registers, regardless the type of variable defined into Device 
Type

●EEPROM parameters are always R/W
●Status Variables are RO by default

● Set to False Read Only in case of R/W Status Variable



Modbus Slave

● In Free Studio Connection, set the Mode of RS485 of the controller to Not 
used
 It means that the RS485 on board is configured as a slave port



Modbus Slave
● In Free Studio Device, in Bios parameters, click on RS485 On Board
●Configure the Modbus communication:
 Address of the controller
Baudrate
Stop bits
Parity

●Change to communication settings
require a controller restart



How to connect EVOLUTION to Megalis target via RS485

●Create a new driver

RTU



Vijeo Designer

●Configure the driver as configured in Free Studio

●A new Modbus equipment has been created

RTU



Vijeo Designer

●Configure the Modbus equipment (right click):
● Enter the address as set in Free Studio
● Select IEC61131 Syntax
● Adressing mode: 1-based (Unity Quantum)

RTU



●Create your variables:

● Define the Data Source: External
● Defin the Scan Group: name of your Modbus equipment you have created
● Specify the register address of the variable

Vijeo Designer
RTU



Chapter 16
Web server

Goal:
Embedded & customized web pages creation
1.Text Base Web Pages
2.Graphical animated Web Pages



Web visualization

1. Open internet browser (Google Chorome)
2. Type 10.0.0.100 in the address bar
3. In the windows security pop-up:
Default Username: administrator 
Default Password: password
► OK

1

4

3

2

Password

Et
he
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Embedded web pages/Home

Customized Web page takes 
higher priority and If it 
already is up-loaded to the 
controller, takes place of the 
embedded one.

Use below address to return 
back to the embedded page: 
http://10.0.0.100/evoindex.htm 

otherwise  just typing IP 
address is sufficient.



Embedded web pages



Web visualization/Customized page

1. Resources► Web site ► Add table page 
2. Name it
3. Add  a new record
4. Select the desired parameter from list
5. Title the page & Select the site basic template
6. Define the control type & Label it

4

3

2

1

6

5



Basic Template

Web folder is located in PLC 
► Web to edit the header



Web site building

Developer ► Build Web site 

Note:
Embedded Web Pages are no longer available 

if Application Web Pages are used

1

2



Web site download/preview

Device ► Connect
►Target Configuration

Web site download
Web site preview

4

1

2

3



Customized pages/Preview

1
2



Customized page inside another page

If the device type is Boolean or Enums other 
types of control are selectable.



Customized pages/Preview & download



Status Variable defenotion for Web Ctrl.



ATV control via customized web page

1



Assigning Status Variables to FB

1

2

3

5

4



Test the Web visualization



Graphical/Status Variable definition

1

2 4

3

4

5 6 If the device type is 
Boolean or Enums 
other types of control 
are selectable.



Graphical Animation principles
64 Pixels

64 Pixels

64 Pixels

64 Pixels

192 Pixels

It moves a fix defined 
frame to the assign 
picture regarding 
defined Enumerators.

1



Project & image foldering

Web

MODE.PNG

Please copy/ cut and paste 
desired image file to 
the web folder located 
in the applicatio folder.



Graphical page configuration
Note.
Do not forget to write the image 
file name in capital letter.

1
2

3
4



Web site building

Developer ► Build Web site 

Note:
Embedded Web Pages are no longer available 

if Application Web Pages are used

1

2



1

2

3

Web site download/preview



Graphical Status Page Test



Graphical Alarm Page Config.

1

2

3

4



Graphical Alarm Page Test



Changing default IP address via Device

2

1



Changing default IP address via Web

2
1







Chapter 17
Wifer Configuration

Goal:
- Wifer Configuration & Connection
- Set the Wifer IP address in the range of Controller



Physical Description



Default settings



LED Description 



WIFER Configuration

Access to WIFER WEB site by www.a.com
●User Name: admin
●Password: admin.

http://www.a.com/


Wifer Default IP address



Wireless network renameing



Connect to the Wireless Network

1 2

3



Adding a device/Controller

1 10.0.0.100

2

2

3



Network status/properties...

1

2

3



... Network status/properties

1

As shown no needed to set the Wifer IP address in the controller address range.



Enabling DHCP/Wifer side



Enabling DHCP/Controller side





Chapter 18
Firmware update

Goal:
Updating SMART & EVOLUTION firmwares by Free Studio Device



Firmware update 

In Free Studio Device

Click on “Connects to Target”
Once the device is connected, 
 Check the firmware version 

If the firmware version is not the
last one, click on BIOS download

Note: Smart, the controller must be powered only by DMI.

Note.
Smart: Application Lost
Evolution: Application kept



Firmware update 

●Click on Browse

●The default folder opened contains the
last firmware version released with
the software. 

Select the last firmware version
Click on Open



Firmware update 

●Select Direct Mode

●Click on Download 

●The same procedure 
can be applied to 
Evolution except for 
Mode selection (not 
available) and power 
supply to be 
provided.



System BIOS version 



Chapter 19
User Interface

Goal:
Local & Remote display programming by User Interface



DemoField Example

CanOpen

EVE1EVD1
Address 2


Dip Switch 1 = ON

NOTE: Leave the CanOpen end resistor jumpers only to the endline Devices, in this case EVD and EVE1



Can Bus wiring recommendations

Use a shielded and "twisted pair" cable with two 0.5 mm2 section conductors (AWG 22), plus 
braid such as Belden cable reference 3105A (characteristic impedance 120 Ω) with PVC sleeve, 
nominal capacity between conductors 36 pF/m, nominal capacity between conductor and 
shielding 68 pF/m.



CAN Termination Jumper
CAN bus jumper mounted
CAN bus jumper NOT mounted

Note: the termination shall be placed at the beginning and at the end of the Can Bus

Note: Star connection are not allowed
OK



Adding a remote display

● Drag & drop from device catalogue to the CANopen
● Or
● CANopen►Add►Device catalogue►Select the target



• 124 or 123 are the 
addresses to be used in 
the HMI management 
menu of EVK

• 124 is the factory 
default

CANopen configuration

1 keyboard to communicate with base ►
set the channel=124
Second keyboard to communicate with 
base ► set the channel=123 



Keyboard EVK configuration

Network settings should 
be aligned to the real 
address of the EVK 
(127 is the factory 
default).



Launching User Interface

Local HMI might not work on remote display
Local & Remote displays (Identical) ► HMI remote
Local & remote displays as future option► HMI remote

1
2

3

HMI:Local Display
HMI Remote: Remote Display

2. Name it ► OK
3. User Interface project 

starts automatically



Project foldering

HMI:Local Display
HMI Remote: Remote Display

2. Name it ► OK ► User 
Interface project starts 
automatically

3 & 4. Local display will have the 
same HMI of the remote one.

Thermostat_exercise.CON

HMI



Local & Remote HMI

1

HMI:Local Display
HMI Remote: Remote Display

2 & 3. Local display will have the 
same HMI of the remote one.

2
3



Preliminary: Actions

Define the global action 
related to the buttons
1. Activate action bar icon
2. Global actions
3. New action
3. Define the Key
4. Define the Action

1

54

2
3



Preliminary: Link parameter file

- Link the parameters file of your application project.
- Select short name to prevent long variable names

1

2
3

4



Target Vars & parameters

• Name can be eventually 
changed manually in order 
to adapt the same UI to 
different project without 
changing the set already 
defined (@ syntax)

• The list of 
parameters/status variables 
will appear

• Note: Remember to refresh 
parameters file every time 
you change the related 
Application project



Toolbar description

1. Insert static
2. Insert new edit
3. Insert new image
4. Insert new animation
5. Insert new button
6. Insert new check box
7. Insert new progress
8. Bring to front
9. Sent to back

1 62 3 4 75

8 9

We will see how to manage all these objects…



Page creation & page properties

1

1

2
3

3

4

Note.
Press Enter to apply 

the changes 
otherwise it will be 
lost.



Page Customization
●Main Page Properties

● Customize grid
● Insert Title Bar
● Define Font size
● Define Title



Page Navigation by Graphic Button

1. Define a new page
2. Create a button in the source page

3. Text/img can be changed base on selection status
4. Define the Action and Action Par properties of the button

1

2

3

4



Main/My First Page…

2 3 4 5

8

76

9

1

1



Text Objects

1. Insert static text

Define the required font size 
(2 sizes are available)

3

2

2

3

1

4

4

4



Text Objects...
●Text to be translated:

1. Define the string ID and the string in the current language
2. Use the ID instead of static string

1 2



Adding 2nd language

12

3

4

●Text to be translated:
1. Languages are defined in the language selection tab
2. String table can be exported/imported and translated



Base Language Import/Export

1

2

1. Export the basic language
2. Open/Edit  the exported text file
3.  Save & Impoert the edited version

3

3



2nd language Import/Export

1

1. Export the basic language
2. Open/Edit  the exported text file
3.  Save & Impoert the edited version

2

3

3



Language switching variable definition

1 2

3

4



Language switching program

1

2

3

4



Tanslator/On-Line



Formaing page/Translation

1

1
Max = 19 Chars



Formaing page/Translation

1

1
2

2. Max = 19 Chars



Edit Objects - Values
1. Select object  or Drag and drop desired variable from from PLC tab

● Main Properties
● Variable: syntax used is: @PLC.<application var name>
● Format
● Selectable: True for R/W, False for RO
● Refresh
● High/Low Limit: shows ----- outside the range

● Select the @PLC.<var> desired
● Default Properties comes from Ap definition
● Selectable: False means, not editable.

11



Edit Objects - Values

Note:
- EEPROM & status variable use syntax 

@PLC.<application var name> 
- Global, local, target  var & PLC vars use 

standard syntax : Just the var name



Edit Objects...

1

1



...Edit Objects...

2
3

2 3



...Edit Objects

3

6

5 5

4
4

1
2



Image Object

1.Import bitmap
2. Browse ► select form image library
3. Select the desired image ► Open
4. Import 

1

2

4

3



Image Object

2

1

2
2

1. Inset new image
2. Properties ► Bitmap ► select the 

desired image from imported list



Local Variables

1. Double click on Page► Local variables (or on Global variables)
2. Add new
3. Define name & type
4. Added to the list
5. Added to the Local variable tree

1

2

4

3

5



Animation-Image lists 

1. Resources► Image lists
2. Add new
3. Name/Rename it
4. Image lists tree

1

2

4

3



Animation/Enum definition

1

3

2

- Insert new animation 
- Rename it if needed (optional)
- Select  from Image list
- Select from property definition
- Filter  variables as page locals



Animation/Manual Mode

1

1

2

2
1

2



Animation/Speed Level

1 2

1

2

1 2



UI simulation

There are two parallel, identical ways to simulate, via UI or Ap 

1

2

3

4



String Table creation



Set creation

1. Double click
2. Add new record
3. Name it, define the type & Dynamic
4. Double click
5. Add new record
6. Browse
7. Select from string list

1
2

34 5

6

7



Strings & v ariables matching

1

2 3

4



Dynamic page creation
1

2

3

4

Note: the item is displayed only if Visible field is TRUE



Strings properties

1
2
3

1

2

3



Page numbering

Note: 
Data type will be define automatically as soon 
as variable recognized, if not there is a mistake 
in the variable name.
1. $ PagIndex=Current Page Number
2. $PagNumber= Total pages number

1 2

1
2



Set creation

1

1. Double clicks
2. Add
3. Type

3.1 Variant: Variable/parameter sets even of not equal type 
3.2  Strings: text

4. Dynamic: compresses the list when invisible variable/parameter are used

3

2

4

Goal: creating a list of 
variables & strings with 
scroll up/down ability



Strings Set filling 



Set Parameter Name

1. Double clicks
2. Select the string form the list
3. Define the visible field
Dynamic visibility: 
If the visible field is False, then 

empty parameter‘s rows will 
be removed from the list and 
the list could be shrink pack.

2
3

1



Set Parameter Value

2

2

1. Sets
2. Format: One decimal point
3. Selectable False in case of RO elements 

3

1



Set Objects/ParName…

Note: The number of elements  of the sets shown in the same page 
should be equal

Syntax:
String:
#Setparname(0), #Setparname(1), …, #Setparname(element x page -1)
Variant:
#Setparvalue(0), #Setparvalue(0), …, #Setparvalue(element x page -1)

1

2

3
4

3

4



Set Objects/ParValue…

Syntax Variant:
#Setparvalue(0), #Setparvalue(0), …, 

#Setparvalue(element x page -1)

6
5

6
5

- Size the text dimension based on the 
longest string to be displayed

- Size the Edit dimension base on the 
biggest digits to be displayed



Set/Objects/Page x out of Y

Note: 
Data type will be define automatically as soon 
as variable recognized, if not there is a mistake 
in the variable name.
1. $ PagIndex=Current Page Number
2. $PagNumber= Total pages number

1
2

1
2



Maximum number of charachters

Number of Chars:
If you do not resize the related window will be 0, and you might face with refresh problem. 
It is possible to set it maximum 21 charachters (>21 Chars=> out of display)



Set Objects/up & down arrows

2

2

1
1

Bitmap 1. BmparrowDown:
2. BmparrowUp:
3. Bmpauto:
4. BmpCool 16*16:
5. BmpGlobe 24*24:
6. Bmpheat 16*16:

6

4

5

3



Slider Objects

3

1

1. Creat new page
2. Configure the page
3. Insert new progress

2

2



Sliders Object‘s proprties

1 432



Slider Objects preview



ATV Control

2

21

2

1



ATV Control

2

2

1

1



System Information...

1 2

1 2

3

3



... System Information

1

1

1

1

1



Simulation



Remember to align Ap UI and Co projects

● “Recompile all”the Application Project

●Compile the User Interface project

●Build the Connection project in order to align it to the linked Ap and UI project



Open Free Studio Device

1.Tools►Open with free 
Studio  Device

2. Define settings
3. Connect to the EVD
4. Download all

1

43

2



Upload HMI from Base to Keyboard...

In the BIOS Menu of EVK (Long press of down + left if a HMI is already 
loaded). 

In order to run HMI:
1. Select HMI Manage
2. upload 
3. Press OK to confirm 
4. Press to run HMI



Upload HMI from Base to Keyboard...

2

3

4

5

6

1



Chapter 20
EVOLUTION USB

Goal:
- DownLoad/UpLoad via USB
- Retain variable configuration



USB device (PC ◄►target)

USB Formated FAT32



What is inside Evolution Filesystem or USB ?

Inside both Evolution/USB Pen Drive:
PLCIEC.COD : Application binary file
HMIIEC.COD : User Interface binary file (not mandatory)
HMIREM.KBD : Remote User Interface binary file (not mandatory)
CONNEC.PAR : Master Connectivity settings (not mandatory)

Inside Evolution:
Webserver files
Logging file
Others…

Inside USB Pen Drive:
PARAM.DAT (.RAW) : Parameter Map file



Parameter map file

PARAM.DAT file includes a set of Evolution BIOS& IEC parameter values. 

PARAM.DAT can be renamed as PARAM.raw in order to skip parameters’ 
range limit check (used in case of par limited by other pars).

PARAM.DAT file can be created via IEC code using the target var 
(see next slides)

PARAM.DAT (.RAW) can be manually created/modified in order to contain 
even a subset of the full map.



Use USB host from IEC code

- Upload an application from the pen drive to Evolution
- Upload/Download a parameter map from evolution to the pen drive.

sysUSBCommand is the system command 
to upload/download to/from USB-Host:

7 = load PARAM.BIN from USBH
8 = load PLCIEC.COD from USBH
9 = load HMIIEC.COD from USBH
10 = load PARAM.DAT from USBH
11 = save PARAM.DAT to USBH
12 = load CONNEC.PAR from USBH
13 = load HMIREM.KBD from USBH
14 = save sysUsbFileName file to USBH, file name can be name. ext or *.ext
15 = load sysUsbFileName file from USBH, file name can be name.ext or *.ext



USB data upload workflow...

1.Connect to the target via Ap
2. Drag & drop sysUsbCommand into the watch window
3. Write value=11

2

3
1

3

2

1



...USB data upload workflow

To monitir the USB-Host status:
Drag & drop sysUsbStatus into the watch window

2
1

3
1

1

2



PARAM.DAT/Protocol Setting



PARAM.DAT/ Physical configuration



PARAM.DAT/EEPROM



Set IP address via USB_H



Firmware Update By USB

How To Update:
• Copy the relevant .bin file into a USB pen drive (e.g. msk423_18.bin)
• Connect USB pen drive to Evolution
• Firmware will be downloaded into Evolution
• Yellow LED will blink during download. 
• Remove USB pen drive as soon as Yellow LED will switch off
• Evolution will automatically reset and will reboot

BIOS are available @<C:\Programs>\Eliwell\free Studio\Catalog\FreeEvolution\<firmware>
<firmware> = msk423 for EVD, msk477 for EVC.

Please Note: a SYSTEM FAULT message will appear - DO NOT CONSIDER -
BIOS upgrade has been completed successfully

Note: Evolution make a filter based on the filename in order to prevent user mistakes 



Automatic Upload via USB pen drive

Uploading automatically an application via USB pen drive
• Copy into a pen drive the COD/PAR/DAT files
• Edit an UPLOAD.TXT file containing the list of the files to be uploaded

Note. PARAM.DAT (.RAW) file can be uploaded only if FREE Evolution has 
been rebooted with related application, therefore PARAM.DAT (.RAW) cannot 
be uploaded at the same time of PLCIEC.COD

The upload file can have a prefix from 00 to 15, for example 03UPLOAD.TXT:
• Copy into a pen drive the UPLOAD.TXT (03UPLOAD.TXT) files as well
Files with numeric prefix are uploaded only if the Evolution dip-switches 
match the prefix; in this way it is possible to store on the same USB pen 
drive one or more Evolution applications.



USB-LED status during upload

The upload process starts when the pen drive is plugged and can be monitored 
through the led status which, during the upload process, are controlled directly by 
Evolution bios.

The process results which will switch on the red led are the ones related to a value of
sysUsbStatus>1.

After the process, Evolution must be restarted in order to run the new application. 
File PARAM.DAT is uploaded by an Evolution only if the Bios Mask and Par_POLI7 of 
the Evolution that has generated the PARAM.DAT are the same as the destination 
Evolution. 

The parameters’ map update does not require to switch off Evolution.



USB application download workflow
Cfg_Node name.par @ project root

Rename it as 00CONNEC.PAR

Project name(PLC).bin @project root ► PLC ► Download

Rename it as 00PLCIEC.COD

Create Text file as shown

Copy them to the USB stick

Project name(HMI).bin @project root ► HMI ► Download

Rename it as 00HMIIEC.COD

Power cycle to apply them into the RAM

Note.
Always use Capital letter in renaming TXT files 

Project name(HMI).bin @project root ► HMI ► Download

Rename it as 00HMIREM.KBD



File Browser Opening

1

2

3



File browser

1. Copy the selected file from browser into the 
USB stick
2. Set the address by renameing 
(00PLCIEC.COD) them
3. Open an TXT file, save it as **UPLOAD.TXT
4. Write/type the commands
5. Set the cursor at last alphabet
6. Enter
7. Save the .TXT file in USB stick

1

3



Using the USB Device - Adding library

IMPORTANT NOTE:
1. USB Device is disabled by default
2. Do not forget: safe to remove the target
3. Do not access EVOLUTION through USB 

device meanwhile any application is 
accessing EVOLUTION filesystem

1

2

3

4

4



Enable/Disable PC host access to file System Function

1

2

3

4

Sys_USBD_Command (USINT 
Command)



PC host connection status function

1

2

3

4

Sys_USBD_status (USINT dummy)



USB device activation



USBD-Controller



M171P - Retain Variables
A RETAIN variable 
indicates that the 
variables within the 
structuring elements are 
retentive, i.e. they keep 
their value even after the 
target device has been 
reset or switched off.

EVOLUTION supports 
up to 100 DWORD 
‘retain variables’ 
ensuring their data 
will not be lost after a 
shutdown.

Retain variable values 
can be changed several 
times without affecting 
internal memory 
performance.

Note: RETAIN variables 
cannot be displayed in 
the Watch window

1



M171P - Retain Variables

2

3

1

4 5

6

1
• Set as variable address size DW (double 
WORD) and data block 102.0.xx where xx=0,...99



Chapter 21
ADVANCE micro SD Card

Goal:
- Mounting micro SD card
- Program storage location settings



Controller's Filesystems Features

The Controller has three possible volumes. Internal NOR flash (8Mb), microSD and 
USB pen drive. Max dimension of the transferred files involving USB pen drive is 
2Mbyte. 

Via this three volumes is possible to:
- Parameters update into the Controller via USB pen drive, NOR Flash or microSD.
- Copy files from USB pen drive to NOR Flash or microSD and vice versa
- Handling files in Applications 
- Read, write, delete files in NOR Flash or microSD via serial communication: 
"file browsing"



micro SD Presense & Mounting

1

3

2

If the microSD card is presented at boot is automatically mounted.



micro SD Command

1

2



Plug and unplug notices:
1. sysMicroSdCommand to request an action.
2. sysMicroSdStatus to monitor the progress of the required action.
3. sysMicroSDdPresence to detect the presence of the microSD.

micro SD handling
In parallel way you can write desired 
command via Application tool by using 
sysMicroSdCommand in watch window.

12

3



Storage selection
● It is possible to download files on different media
●Each kind of file type will be loaded from the selected media



Download settings

2

1. Please note that by changing the 
download settings from NOR to SD the data 
file storage location remains on the NOR 
flash.

2. If you want to change DATA Parameters 
storage location you have to handle it via 
Device tool as it shown.

1



Programm volumes/My Computer



Programm volumes
/ File browser

1

2

3

5

4



Chapter 22
ADVANCE new features

Goal:
- Halt & Restart Modes
-Cycling time settings & monitoring as run time 
status
- Analogue I/O configuration
- Virtual Dip Switch setting
- Battery Handling



Running Modes

2

1. HALT :You can stop the PLC execution
2. COLD RESTART : The PLC application execution will be restarted and both retain and non-
retain variables will be resetted. 
3. WARM RESTART : The PLC application execution will be restarted and only non-retain 
variables will be resetted. 
4. HOT RESTART : The PLC application execution will be restarted and no variables will be 
resetted.
5. REBOOT TARGET : You can reboot the target  

1

2 543



Cycling time setting

1
2 3

It is only possible to set the Timed task 
period  and background task executes in 
lower priority after Timed task execution.



PLC Run time status

1
2

3



AI Configuration
In particular, we have that couples (AI1, AI2) and (AI3, AI4) and … (AI11, AI12) must be complied with this 

truth table where: 

0=NTC(NK103)             
1=DI                       
2=NTC(103AT)             
3=4÷20mA                  
4=0÷10V                                      
5=0÷5V (Ratiometric)      
6=PT1000                  
7=hOhm (pull-up 10K)                     
8=daOhm (pull-up 2K)
9=PTC
10=0÷5V 
11=0÷20mA 

The cells marked with X indicate combinations of Cfg_AI1 and Cfg_AI2 eligible. Choices outside causing the 
error indication 0x8003 field value of the two probes. Same table when you consider the other couples.

Cfg_AI1

0 1 2 3,11 4 5 6 7 8 9 10

Cfg_AI2

0 x x x X

1 x x X X

2 x x X X

3,11 x

4 x

5 X X

6 X X x

7 x x X x

8 X X X

9 X X X

10 X x



Analogue I/O configuration

1

2 (*) Cfg_AIx = 7 Resistance value read, 
expressed in hΩ, for a resistance 
applied to the input using the controller 
in NTC configuration, i.e. creating a 
divider with pull-up resistance of 10k. 

(**) Cfg_AIx = 8 Resistance value read, expressed in daΩ, for a 
resistance applied to the input using the controller in PT1000 
configuration, i.e. creating a divider with pull-up resistance of 2k. 



Analogue I/O notes

●Note: Typically used with potentiometer at input.

●The resistance range for the hΩ(NTC) configuration is up to 150K, and up to 
30K for the daΩ(PT1000) configuration.



Virtual Dip Switch...

-USB files may provide numerical prefix from 00,01,02 ..., 07. In 
particular, when the files are in the USB stick:

1. if you did not have prefix that these can be downloaded from 
the stick to the Controller regardless of the value of the 
virtualDipSwitch parameter of the Controller.
2. if they have prefix they are downloaded to Controller only if the 
prefix is equal to virtualDipSwitch  parameter of the controller.

-This allows you to get on the same USB stick files of the same 
type on a different Controllers. For example if virtualDipSwitch of 
the Controller has value 7 the file with prefix 07 
(eg: 07CONNEC.PAR) will be considered by this Controller.



...Virtual Dip Switch

 virtualDipSwitch  can be identified also via green led at Controller power-
on/reset immediately after the "USB-Host: OK" indication. 
 The green led blink as the value of virtualDipSwitch. 
 If the green led stay on it means that the value is 0. This phase spend 4 

seconds. 
 For instance if the value is 0 the green led stay ON 4 seconds, if the value is 2 

the green led flash 2 times and wait OFF for 3 seconds



Battery Handling
●The Controller has a BR2032 battery inside. To guarantee 10 years life there 

is a procedure to follow before put the Controller in storage.
●This procedure works only if the Controller is NOT powered by USB-device 

connector.

●Before power-off the Controller the 16bit register 8716 has to be set at 12345. 
Then the Controller can be switched-off. This procedure guarantee that the 
microcontroller go into Deep-Power Down Mode when the power is switched 
off.

●This is to solve a bug in the microcontroller silicon (5% of microcontrollers).
●Battery can be removed, it is closed to microSD slot



Chapter 23
Documentation

Goal:
Creating document and exporting by Application, 
Device & User Interface as report or as using them 
by other products such as Vijeodesigner



Available Resources

EVOLUTION

SMART



Used Resources

1



System Task Execution Time



Application - Export to Excel...

1

2

3

4



... Export to Excel

Name Type In/Out Description
AI1_E INT in
DI1_E BOOL in
DI2_E BOOL in
DO1_E BOOL out
DO2_E BOOL out

1
2

3



User Interface - Documentation

2

3

1



User Interface - Documentation



Device - Export to Text file...
Select a Table



Device - Export to Text file...

1 2

3



Chapter 24
CAN Binding

Goal:
Reading an Integer value in both directions PLC1◄► PLC2



CAN Binding architecture

1 2

Max 2

9

Up to 10 Advance in the network + 2 Remote 
Keyboard.The same for M171P:

Each Advance can send 8 PDO with 8 byte 
each (32 Word).
Each Advance can receive 8 PDO with 8 
byte each (32 Word).

9



Can Bus wiring recommendations

Use a shielded and "twisted pair" cable with two 0.5 mm2 section conductors (AWG 22), plus 
braid such as Belden cable reference 3105A (characteristic impedance 120 Ω) with PVC sleeve, 
nominal capacity between conductors 36 pF/m, nominal capacity between conductor and 
shielding 68 pF/m.



CAN Termination Resistor & Jumper
CAN bus jumper mounted
CAN bus jumper NOT mounted

Note: the termination shall be 
placed at the beginning and at the 
end of the Can BusNote: Star connection are not allowed

OK



CAN Binding Hardwarw Wiring

L
H
GND

PLC 1 PLC 2

Note. Do not forget 
to install 120 Ohms 
termination resistors 
even in short  
wire/cable distance.



CAN Configuration

2
1

Note:
As CANopen port configured as 
Binding, Expansion module/s  or 
Remote Keyboard/s connection/s 
is/are not possible any more.

3.  Drag & Drop it to the CANopen link

3
4



Add 2nd controller & applications

1

3

Note. Only one connection 
link is needed.
5 & 8. Automatically opens 
related Application tool

2

5
6

8

4

7



Project foldering

Only one connection link for both 
controllers is needed.

PLC1

PLC1

PLC2

PLC2

CANBinding.CON



Network Definition

1

2

PLC 1 PLC 2

3

They should communicate in the same network



PLC 1, Status variable definition

2

1



PLC 1, I/O mapping

2

5

1

3

4



PLC 2, Status variable definition

2

1



PLC 2, I/O mapping

2

1

3

4
5



PLC 1, Assigning Status Variables

1

2

3 4

3

4



PLC 2, Assigning Status Variables

1

2

3 4

3

4



Project Compilation

PLC 1

PLC 2

1
PLC 1

PLC 2

2

3

4

5

6

7

8

9

10



PLC 1, On-Line Debugging Mode

Note. Peripheral vectors are only 
used for expansion modules 
monitoring not CAN Binding

2

5

4

1

3



PLC 2, On-Line Debugging Mode

Note. Peripheral vectors are only 
used for expansion modules 
monitoring not CAN Binding5

2

4

1

3



Chapter 25
Modbus Master Communication via 
iEM3155 Energy Meter

Goals:
Connection Energy Meter to the ADVANCE via 
Modbus serial line
Read Energy, Power, Voltage, Current & 
Frequency values
FLOAT32 conversion to UINT
RS485 communication Error Detection



Machines architecture

Programming
Port

or BMS 
Modbus
Master

Magelis Family Range

Modbus Slave
USB/RS485

Energy Meter
iEM3155

ATV212/21 

Modbus Master 

3rd Party Modbus 
slave device

Only one of on Board RS485 SL’s can be either Master or Slave

M171O 



Display overview



Modbus Wiring & Status LED



RS 485 connection/ADV & iEM3155

Up to



Power Wiring/Single Phase...



Power Wiring/Three Phases



Basic Configurations/Clock settings

1

These instructions 
only apply on initial 
power up.

1
19200
Even

2



Meter Data...



Meter Data



RS485 Configuration

1

2

3
4

1. Configure the desired 
Modbus Port.
2. Set the Modbus properties 
aligned with Master
3. Drag & Drop generic Modbus
link and rename it
4. Set the Modbus address and 
related node number for further 
monitoring/debugging



Link IEEE754 library

1

1. Used for conversion
Word2IEEE754:
Converts 2 words to Real



Status Variable Declaration

1 2



Conversion

1

Word2IEEE754:
Converts 2 words to Real

To_UINT:
Converts Real to UINT



Energy addresses & Assignments

1

2

3
4



Power addresses & Assignments

1

2

3
4



Voltage addresses & Assignments

1

2

3
4



Current addresses & Assignments

1

2

3
4



Frequency addresses & Assignments

1

2

3
4



Live Debug Mode...

Activate Live debug mode



...Live Debug Mode



Live Debug Mode/Watch Window

Drag & Drop

1 2



sysMbMRtuNodeStatus



Modbus Communication Error detaction

1

2

3
4



Live Debug Mode

Communication Failed

Communication OK

1

2

3

4



Troubleshooting
Experience sharing



M171 Optimized



Driver DMI (Only SMART)

●Problem:
● The customer cannot find the driver for the DMI to install it on his PC

●Solution:
● The driver is automatically installed in the SoMachineHVAC folder
f.e. C:\Program Files (x86)\Eliwell\free Studio

->atmel_avr_mega_cdc.inf



Connection PC<->SMART Mbm Master 

●Problem:
● The customer cannot connect in SoMachine HVAC to the controller

●Solution:
● If the customer is using SMART Modbus Master, he is not able to connect to the 

controller anymore if the controller is running.
● You can connect during the booting of the controller and disable Master function



SMART Bios upgrade is not working

●Problem:
● The upgrading of the BIOS of the SMART is not working. Starts correctly but ends 

with error message.

●Solution:
● Take care that you supply the SMART only with power from the DMI and no

external power supply is connected. Because the DMI must switch off and on the 
controller during the update and if external power supply is connected this is not 
possible.



SMART electrical isolation - DMI

●Problem:
● The M171 optimized have no galvanic isolation of the power supply – I/O’s

●Solution:
● Take care when you connect the DMI to the SMART, if the SMART is supplied also 

with external power supply.
● If the external power supply or a GND pin is connected to ground and you connect 

at the same time the DMI, the DMI or USB port or Controller can be burnt. So 
remove external supply before connection DMI or remove the Ground from the 
external supply and the GND pin.



SMART electrical isolation - AO

●Problem:
● The SMART have no galvanic isolation of the power supply – I/O’s

●Solution:
● Take care when you have AC power supply and using a actuator on analog output 

with same Common pin, then you need second power supply for the actuator.
● If you use DC power supply, this is not a problem and you need only one DC 

power supply.



SMART Power Supply connection notes

Particular attention has to be placed when connecting an uninsulated 0-10 active probe 
with a SMART device.

In the following pages has been highlighted some WRONG
and the CORRECT connection scenario.
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Power Supply 
24v DC

+ -

GND

AO/AI

CORRECT (with DC Power Supply)

ACTUATOR / PROBE
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EVOLUTION



Connection PC<->EVOLUTION Mbm Master 

●Problem:
● The customer cannot connect in SoMachine HVAC to the Evolution, via the USB-

RS485 Converter

●Solution:
● If the customer is using Evolution Modbus Master, he is not able to connect to the 

RS485 port anymore, which is set as Master, if he is using USB-RS485 converter.
● You can connect via other communication port (CAN, Plug-in), or you download a 

CONNEC.PAR via USB where the RS485 port is set as slave.
● Access via USB to the controller and delete the file CONNEC.PAR



FLASH data storage on EVOLUTION

●Problem:
● If you write too often into the FLASH of the Evolution, this could create problem.

●Solution:
● Take care, that you are not more often then every 10 minutes writing something

into the FLASH. If you have to store in shorter cycle values, you can f.e. write the
values in local vars or Retain (only Evolution) and save these data every 10
minutes to FLASH.



CAN Termination Jumper
CAN bus jumper mounted
CAN bus jumper NOT mounted

Note: the termination shall be placed at the beginning and at the end of the Can Bus

Note: Star connection are not allowed
OK



EVOLUTION general



Connection PC<->EVOLUTION 

●Problem:
● The customer cannot connect in SoMachine HVAC to the controller

●Solution:
● Check the COM-Port of the DMI/RS485 converter in Windows Device Manager or 

IP-Address (only Evolution)
● Make the “Network scan” in SoM HVAC Device to find the correct settings



FREE Studio HVAC - general



«Warning » in  FS HVAC Application

●Problem:
● Compiler shows warning: Signed/unsigned mismatch

●Solution:
● Change datatype of variables that both have the same datatype 
f.e. INT:=INT; 
● Use standard block f.e. TO_INT to convert the datatype
INT_VAR:=TO_INT(UINT_VAR); 
Pay attention, because you could have an overflow



« Warning » in FS HVAC Application

●Problem:
● Compiler shows warning: Accumulator extension

●Solution:
● Change datatype of variables that both have the same datatype 
f.e. BOOL:=BOOL; 
● Use standard block f.e. TO_BOOL to convert the datatype
INT_VAR:=TO_INT(BOOL_VAR); 



Correct data type for FC/FB + description

●Problem:
● You are not sure which data type is requested at which input of the Function or 

Function Block.

●Solution:
● Make a right mouse click on the FC/FB and choose Object properties. There you 

can see which data type at the in/output is requested and a short description of 
this block.



Application – program is doing nothing

●Problem:
● A program is developed and donwloaded to the controller, but it is doing nothing.

●Solution:
● Forgot to assign the program to a Task. You can assign it afterwords.



EEPROM default values are not written

●Problem:
● The Default values of the EEPROM parameters are not written into the controller

●Solution:
● Remember, that you can only write the Default values of the EEPROM 

Parameters in FS HVAC - Device



EEPROM Parameters limited write access

●Problem:
● If the EEPROM Parameters are saved more then 100.000 times, the EERPOM 

get defect.

●Solution:
● Take care, that you are not storing EEPROM parameters too often (very bad 

every cycle!!!). You can f.e. example let the working hours counter run in local 
variables and save only once per hour the value in EEPROM. Or in case of 
Evolution you can also use the Retain variables.



Overlapping address

●Problem:
● Compiler gives an error message - ERROR: Duplicate or overlapping parameter 

address: xxxx
● Changed the application type of a EEPROM parameter or status variable 

afterwards when already other parameters/variables exists in the table

●Solution:
● Mark all the parameters/variables and push the button « Recalc », the the 

addresses will be new assigned.



Invalid variable name

●Problem:
● Compiler gives an error message - ERROR: (GeneratePlc) Invalid PLC variable 

name: äüö

●Solution:
● Never use space character or special character (f.e. äöü! »§$%&…)when you are 

creating a Variable, Parameter, IO Mapping, Programm…



Status Variables – Min/Max/Default

●Problem:
● You cannot write a value into the Min, Max and Default of a Status Variables.

●Solution:
● If you create a new Status Variable, it is as standard created as Read only. In 

that case it’s clear that you cannot create a Min, Max and Default value. Change 
to Read only - FALSE



Check software and firmware version

●Problem:
● If the controller shows abnormal behavior, check the software version and also 

the firmware BIOS of the controller. And always when a new FS HVAC version is 
released, and you work on old project you have to update.

●Solution:
● Check software version in Application -> Project -> Select target… and also for 

HMI in User Interface and Connection (right click on Device -> Change)
● Check Firmware/BIOS of the controller. Therefore connect in Device to the 

controller and see in Mainscreen.



Change BIOS parameter

●Problem:
● You changed BIOS parameter, but the change is not active.

●Solution:
● If you change any BIOS parameter, you have to switch OFF and ON the controller 

that the change will be applied. (Remember, that at Optimized the controller is 
also powered via the DMI, so disconnect also the DMI for reboot.)



EVOLUTION User Interface

●Problem:
● Compiler gives an error message - PAGE:main$EDIT:Edit_1 - error V2308:  * => 

Associated variable does not exist

●Solution:
● In an edit field is a wrong variable name assigned or no variable is assigned.



Thank you



Q & A



Thanks



Appendix 1
Data Types



Data Types/Integer

BYTE, WORD, DWORD, SINT, USINT, INT, UINT, DINT, and UDINT are all 
integer data types Each of the different number types covers a different range 
of values. The following range limitations apply to the integer data types:



Data Types/Bool

●BOOL type variables may be given the values TRUE and FALSE. 
8 bits of memory space will be reserved.



Data Types/Integer (INT)

Signed type with a 16-bit format.
This table shows the range in each base.



Data Types/16 bit data registers

16 bit data range:

0000h – FFFFh (Hex)
0-65535 (Decimal)

0:= positive number
1:= negative number

16 bit data



Data Types/Double Integer (DINT)

Signed type with a 32-bit format.
This table shows the range in each base.



Data Types/32 bit data registers

32 bit data range:

00000000h –
FFFFFFFFh (Hex)
0-4 billion (Decimal)

0:= positive number
1:= negative number



Data Types/Unsigned Integer (UINT)

Unsigned type with a 16-bit format.
This table shows the range in each base.



Data Types/Unsigned Double Integer (UDINT)

Unsigned type with a 32-bit format.
This table shows the range in each base.



Data Types/Examples



Data Types/Byte Type
The Byte type is coded in 8 bit format.
This table shows the lower/upper limits of the bases which can be used.

Example



Data Types/Word Type
The Word type is coded in 16 bit format.
This table shows the lower/upper limits of the bases which can be used.

Example



Data Types/Dword Type
The Dword type is coded in 32 bit format.
This table shows the lower/upper limits of the bases which can be used.

Example



Data Types/Float:Real & LReal

●REAL and LREAL are so-called floating-point types. They are required to 
represent rational numbers.

32 bits of memory space is reserved for REAL and 64 bits for LREAL.



Data Types/String

●A STRING type variable can contain any string of characters. The size entry 
in the declaration determines how much memory space should be reserved 
for the variable. It refers to the number of characters in the string and can be 
placed in parentheses or square brackets. If no size specification is given, the 
default size of 80 characters will be used.



Data Types/Time & Date
The Time type T# or TIME# is represented by an unsigned double integer 

(UDINT), It expresses a duration in milliseconds, which approximately represents 
a maximum duration of 49 days.

The units of time authorized to represent the value are:
● days (D)
● hours (H)
● minutes (M)
● seconds (S)
● milliseconds (MS)



A data item can be:



Arrays
What Is an Array?
It is a data item that contains a set of data of the same type, such as:
for example:
● a group of BOOL words,
● a group of UINT integer words,
● etc.
Characteristics
An array is characterized by two parameters:
● a parameter which defines its organization (array dimension(s)),
●a parameter that defines the type of data it contains.



Structures

What is a Structure?
It is a data item containing a set of data of a different type, such as:
●a group of BOOL, WORD, UNINT, etc. 
●a group of tables
●a group of REAL, DWORD, tables, etc.

Characteristics
A structure is composed of data which are each characterized by:
● a type,
● a name, which enables it to be identified,
● a comment (optional) describing its role.



Special data registers: constants

Notation: K

Role: decimal constant values

Types: 16 (-32768 - +32767) and 
32 (-2147483648 - +2147483647) bit

Usage: in counters, timers, instruction 
parameters

Notation: H

Role: Hexadecimal constant values

Types: 16 (0 - FFFF) and 
32 (0 – FFFF FFFF) bit

Usage: in counters, timers, 
instruction parameters



Data Types

SINT short integer 1 byte
INT integer 2 bytes
DINT double integer 4 bytes
LINT long integer 8 bytes
USINT unsigned short integer       1 byte
UINT unsigned integer          2 bytes
UDINT unsigned double integer 4 bytes
ULINT unsigned long integer 8 bytes
REAL real 4 bytes
LREAL long real 8 bytes
BOOL boolean 1 bit
BYTE byte 1 byte
WORD 16 bit bit string 16 bits
DWORD32 bit bit string 32 bits
LWORD 64 bit bit string 64 bits



Break
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